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October 21, 2011

1 Introduction

Today’s lab is meant to introduce you to DDD, the Data Display, Debugger.

• If you have not used DDD, Section 2 below will help you get familiar with it.

• If you are already familiar with DDD, you can move directly toSection 3 on page 5, which contains some small,
focused exercises related to your binary bombs.

• Finally, whether you are familiar with DDD or not, you’ll finda selection of little-known commands in Section 4
on page 7. These commands will be useful for defusing bombs.

2 A step-by-step guided experience with DDD

To get an example program, try

git clone /comp/40/git/ddd-demo

cd ddd-demo

sh compile

This should give you a binaryppmtrans. You’ll see that the block-major rotation is buggy:

1. Run both of the following:

./ppmtrans -rotate 90 < rand105x104.pbm | pnmscale 5 | display &

./ppmtrans -rotate 90 -block-major < rand105x104.pbm | pnmscale 5 | display &

(The program is also buggy in that it only accepts images fromstandard input.)

2. Before running the debugger,always check withvalgrind:

valgrind ./ppmtrans -block-major -rotate 90 < rand105x104.pbm > /dev/null

In this casevalgrind won’t help us!

3. Start DDD:

ddd --debugger "gdb -d /usr/sup/src/cii40" ppmtrans

4. Close the tip of the day

5. You’ll see a window with three panes:
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• A blank field where you can display data

• Source code

• A window for interacting withgdb

(If you’ve used DDD for other projects, it remembers the old layout, so you may see something different.)

6. Given the buggy output, I want to know if the big black areasare blocks. So I’m going to stop inUArray2b_new
to see what happens. To set a breakpoint there, typeUArray2b_new in the small input window following “():”
and then hit the stop sign to the right.

7. Next choose “Run. . . ” from the Program menu

8. Fill in the arguments

-rotate 90 -block-major < rand105x104.pbm > /tmp/r.ppm

and click the Run button.

9. Your source-code window should now showUArray2b_new with a red arrow and a stop sign. Double-click the
blockArray variable.

10. A box should appear in the data window. It shows a pointer value. Because the variable is uninitialized, I can’t
predict the value.

11. Click the Next button four times. At this point

• The data display should have changed.

• The red arrow should be pointing to the declaration ofint bwidth.

12. Let’s display theblockArray. Right-click on the box in the display window, and from the menu select “Display
*().” That meansfollow the pointer. A box displaying the struct should appear.

13. The display shows thatblocksize is 73. Whatever is going on, that’s significantly larger than the black blotches
on the bad output.

14. Use the Next button to step down just before thefor loop.

15. The display of theblocks field changes. Follow that pointer using the “Display *()” from the right-mouse
menu.

16. The result says we have 2-by-2 blocks of size 8. If we try tofollow the rows pointer, we can’t see it—it’s an
abstract type.

17. Let’s letUArray2b_new finish. Click the Finish button.

18. We were called fromUArray2b_new_64K_block. Click Finish again.

19. Keep clicking Finish until you get to the assignment

image = Pnm_ppmread(stdin, methods);

20. Further down the same pane you should be able to see someif statements that include the case

if (rotation == 90)

To be sure of stopping there, double-click therotation variable.

21. You should get a data display showingrotation is 90. Let’s stop at the assignment toA2 temp. Double-click
in the left margin of that line; a stop sign (breakpoint) should appear.

22. Now let’s continue execution until we reach the next breakpoint: click the Cont (continue) button.
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23. We hit the breakpoint inUArray2b_new again, and it tries to bring back the old data display. It won’t work
until things are initialized. Single-step using the Next button until the struct appears and theheight, width,
andblocksize fields are displayed with their correct values.

DDD remembers what data you were interested in, and the data is displayed on every trip through the same
procedure.

24. So far all looks well, so let’s continue to the next breakpoint by pressing the Cont button.

25. You’re now just before the assignment totemp. Takeone step by clicking the Next button once.

26. We suspect some problem in themap or rotate90 functions. We’re going to “step inside” these calls by using
the Step button. Click it once.

27. We’re in a method suite. “Step inside” the call toUArray2b_map by clicking Step again.

28. Double-click thearray2b parameter to see its value.

29. Right-click the data display to see the fields of the struct.

30. Right-click theblocks field in the data display.

31. Using the Next button, single step down to thefor loop.

32. Hover the mouse over thebheight variable. It should show “2.” Do the same for thebwidth variable.

33. I see no obvious faults in themap function. Let’s set a breakpoint just before the call toapply, by left-clicking
in the left margin of that line.

34. Run to the breakpoint by clicking Cont.

35. Hover the mouse overi, j, n, andtemp. All should have reasonable-looking values. (If a pointer value is
roughly nearby other pointer values, it is definitely reasonable. Other kinds of pointers—to global or local
variables—might also be reasonable.)

36. Let’s “step inside” with the Step button. Keep stepping until you get to a staticheight method. That’s not
interesting, so let it Finish.

37. Step again; you should be inside therotate90 function. If you want you can look at thesrc variable.

Step again, and you’ll be inside a staticat method. Step once more, and you’ll be insideUArray2b_at, where
you can check to see the parameters are sensible.

38. FinishUArray2b_at.

39. Finish the staticat method.

40. Withrotate90 on the source-code display, use the bottom (gdb) pane and type

print UArray2b_size(temp)

It should confirm the size is 8 (the size of a pointer).

41. Again I see no obvious faults, so let’s Finish therotate90 procedure.

42. We’re back in themap function. Right-click the stop sign and choose “Disable breakpoint” from the menu. It
should become grayed out.

43. Now let’s let themap function Finish.

44. Also Finish the staticmap_block_major method.

45. Finish again and we’re back inmain. Let’s see if we can find anything wring withnewImage.

46. Enlarge the data pane by dragging the small square on the right-hand side of the line that separates the data pane
from the source-code pane.

47. Double-clickimage in the source-code window.
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48. Double-clicknewImage in the source-code window.

49. Follow pointers.

50. You can’t double-click either of thepixels fields, because they have typevoid*. Instead, in the very top input
line, next to():, edit in

(UArray2b_T)image->pixels

and click the “Display” flashlight button.

51. Do the same with

(UArray2b_T)newImage->pixels

52. From the output, we know that pixel(0, 1) is unexpectedly read. In the display window, type

(Pnm_rgb)methods->at(newImage->pixels, 0, 1)

and click the Display flashlight.

53. Something looks very wrong. What about

(Pnm_rgb)methods->at(newImage->pixels, 1, 0)

This looks bad.

54. Let’s look at the original image. But the data pane is getting crowded. Instead try thegdb pane:

print *(Pnm_rgb)methods->at(image->pixels, 0, 103)

print *(Pnm_rgb)methods->at(image->pixels, 0, 104)

Oops! my arithmetic is bad, but theUArray2b implementation let that reference go without a bounds check!

55. How about

print *(Pnm_rgb)methods->at(image->pixels, 0, 102)

All these pixels are black. Yet the pixel in the rotated imageis not black!

56. Let’s try the program again. Typerotate90 into the input box at the very top, and click the Lookup buttonwith
the target.

57. Double-click the assignment todest to get a breakpoint.

58. Right-click to get the Properties menu.

59. In the Condition box type

i == 0 && j == 102

60. Click Apply. You should see a question mark added to the stop sign.

61. Click Close.

62. Let’s re-run the program from the start. Click the Run button.

63. We hit a breakpoint inUArray2b_new. Disable it with the right mouse button and continue.

64. We hit breakpoint 2 assigning totemp. Disable it with the right mouse button and continue.

65. Finally we hit breakpoint 4.

66. Step inside twice to get toUArray2b_height.

67. Finish to get to the method suite.
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68. Finish again to get back to therotate90 function.

69. Use the flashlight to display thesrc variable.

70. Follow the pointer. The original pixel is white. That is,red, blue, and green are all set to 1.

71. Hmm. Maybe we are not pointing at the pixel?

Double-clickelem to display a pointer to the pixel.

72. In the display window, type

methods->at(a, i, j)

and click the Display flashlight.

73. Aha! Theelem pointer we are given does not actually point to coordinates(i, j).

74. Right-click the breakpoint inrotate90, and change the condition to

elem != methods->at(a, i, j)

75. Restart the program, and we can see that it goes wrong almost right away, at(i, j) coordinate(1, 0).

At this point, the best plan is to abandon the debugger and findout why themap andat functions are inconsistent.
We’ll find that the math in thecomment for map is consistent with thecode in at, but the comment and the code are
inconsistent—the quotient and modulus have been swapped.

One final point: this fault could have been caught easily by placing the conditional assertion

if (i + j == 1)

assert(UArray_at(*temp, n) == UArray2b_at(array2b, i, j));

in the loop. I bet this assertion would have cost practicallynothing.

3 Reverse engineering your bomb using DDD

The principle behind today’s lab is that when you’re reverseengineering, if you are not certain of what you’re seeing,
work the problem from both ends. That is, create a short C program, compile it, and see ifobjdump explains the results
you are seeing.

sscanf and pointers into the stack

If you are not sure of howsscanf points, or if you are not understanding address arithmetic related to the stack pointer,
then this exercise is for you.

Write and compile a function that reads three unsigned long integers:

struct three_unsigned_longs {

unsigned long a, b, c;

};

void read_three_unsigned_longs(const char *inputline,

struct three_unsigned_longs *p);

/* uses sscanf to read three unsigned long integers from

’input line’, and places the results in the fields of the

structure pointed to by p */
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(My implementation ofread_three_unsigned_longs takes just 3 lines, two of which are used to explode the
bomb.) Examine the results withobjdump -d. Look at your own code and also at themain function.

You can get the header file above, a testmain, and a compile script by

git clone /comp/40/git/code

Put your function in filetul.c and compile withcompile-code-lab.

jmp *something and the switch statement

If you see ajmp instruction with a star (*), you are seeing acomputed goto, which most likely has to do with aswitch
statement. This stuff is covered pretty well by Bryant and O’Hallaron in Section 3.6.6. The “pidgin C” in Figure
3.15(b) may be helpful, but I would definitely check out the assembly code on line 4 of Figure 3.16, and you can see
the jump table on the next page. Everything in your code is similar except that your machine uses 64 bits instead of
32 bits:

• %eax becomes%rax.

• a 32-bit pointer (4 bytes) becomes a 64-bit pointer (8 bytes), so the multiplier in the effective address becomes 8,
not 4.

If you have an instruction like

jmpq *0x401b90(,%rax,8)

Then you can view this as indexing into an array of 64-bit pointers located ata = 0x401b90, and you are computing
a[rax], which in address arithmetic translates toa + 8 * %rax.

It’s possible to reconstruct the array of pointers by using

objdump -s -j .rodata bomb99

but I recommend against this method. It is far easier just to get the debugger to show you the target address; put

((void *)0x401b90)[$rax]

in the DDD window and click the flashlight.

If after consulting the book, you are still not sure what is going on, you might want to compile and objdump the file
aspect.c:

#include <stdbool.h>

enum tx { NONE, ROT90, ROT180, ROT270, FLIPH, FLIPV, TRANS };

bool changes_aspect(enum tx transformation) {

switch (transformation) {

case NONE: return false;

case ROT90: return true;

case ROT180: return false;

case ROT270: return true;

case FLIPH: return false;

case FLIPV: return false;

case TRANS: return true;

}

return false;

}
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Push, pop, and computation on the stack

In Monday’s class we’ll talk a bit about the call stack and howit works, but for purposes of analyzing stack code,
your best bet is to simulate the execution of the code, keeping track of the state of the stack and the registers. A good
example program would be the “three unsigned longs” code in the exercise above. Here’s what’s useful to know:

• The stack grows downward, so younger activations are at smaller addresses.

• Just before a call, the stack pointer%rsp must be a multiple of 16 (aligned on a 16-byte boundary).

• The call instruction pushes a pointer to the return address,so just after a call—and therefore at the beginning
of every procedure—the stack pointer points to the return address, and it is equal to 8 modulo 16. If a function
therefore needs to make another call, it has to restore the invariant that the stack pointer before a call is a multiple
of 16. This requirement is the source of the mysterious code in some functions that subtracts 8 from the stack
pointer without actually using any space on the stack.

• Any push instruction subtracts from the stack pointer and writes a word to the stack, all at one go. Apush
instruction is often used to save the value of a register; thevalue can be restored with a correspondingpop

instruction.

Why? Certain registers arepreserved across calls. A function is allowed to use those registers only if it guar-
antees to save their values on entry and restore them on exit.The ones you are most likely to see are%rbx and
%rbp; your overview handout has the complete list.

• Keep in mind that althoughthe stack pointer may move, the values on the stack do not move. Your best bet is
to draw a picture of the stack and to give a name to each location you find there. You can then “play computer”
and execute the code by hand, using the names of the locationsto see what the code is doing.

4 Commands and menu entries for machine-level debugging

DDD is designed for debugging source code—by continuously displaying the contents of mydata structures, it really
improves my debugging productivity. But at the machine level, there are no stinkin’ data structures—just sequences
of stuff in memory. Here are some little-used tricks that will help:

• Selecting Machine Code from the View menu gives you a view of the assembly code.

• To single-step by machine instructions, use the Stepi and Nexti commands. The Finish command is also useful.

• The Backtrace command on the Status menu will tell you where you are. It’s quite useful for general debugging,
but for the binary bomb, you may not need it.

• The Memory command on the Data menu is great for looking at arrays. It can also look at structs if the members
of the struct are mostly the same size.

• The Watchpoints command on the Data menu can stop the programwhen the contents of a memory location
change.

• You can view all the registers using the Registers command from the Status menu. But on a modern CPU this is
a bit overwhelming. You’re better off asking for individualregisters in the display window.

For reasons only Richard Stallman knows, the registers are named using dollar signs, not percent signs. For
example, the%rdi register is called$rdi.

• For best view of a register, you should cast it in a C expression. For example, suppose you think%rdi holds a
pointer to a string. Then you display*(char **)$rdi. Or suppose you think it holds a pointer to a pixel. Then
you would display*(Pnm_rgb)$rdi.
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